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Introduction 

OpenNSPECT is the open-source version of the Nonpoint Source Pollution and Erosion 
Comparison Tool that examines the relationship between land cover, nonpoint source 
pollution, and erosion. OpenNSPECT is a plug-in for the free, open-source geographic 
information system (GIS) software package MapWindow GIS. OpenNSPECT is designed for use 
with any watershed, provided the user has access to the necessary data. This user’s manual 
provides a detailed description of the interfaces within OpenNSPECT and the data required to 
perform an analysis. The separate technical guide explains in more detail where the data that 
are distributed with OpenNSPECT were acquired and how the data were processed to be 
compatible with OpenNSPECT. 

OpenNSPECT uses spatial elevation data to calculate flow direction and flow accumulation 
throughout a watershed. To do this, land cover, soils, and precipitation data sets are processed 
to estimate runoff volume at both the local and watershed levels. Coefficients representing the 
contribution of each land cover class to the expected pollutant load are also applied to land 
cover data sets to approximate total pollutant loads. These coefficients were derived from a 
combination of relevant studies and local water quality sampling data or taken from published 
sources. The output layers display estimations of runoff, pollutant loads, pollutant 
concentration, and total sediment loads. These layers can help resource managers make 
informed decisions about water quality and what areas to target for improvement, as well as 
predict the impacts of management decisions on water quality. OpenNSPECT also provides 
functionality to compare current land cover conditions to proposed changes in both land use 
and land cover. 

Note: Data provided with OpenNSPECT are for the Wai‘anae area, located on the western side 
of O‘ahu, Hawaii. The technical guide explains in more detail where the data were acquired for 
the Wai‘anae study area and how the data were processed to be compatible with OpenNSPECT. 
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1. Getting Started 

1.1 Installing MapWindow GIS 

The MapWindow desktop software is available through free download as a single ready-to-
install .exe file from the MapWindow website: www.mapwindow.org. Installation requires 
administrative privileges on the target computer. MapWindow is a native Windows application 
that requires installation of the Microsoft .NET framework. It runs on XP, Vista, and Windows 7. 
A Quick Start Guide is available on the MapWindow website. 

1.	 Download the MapWindow GIS installation software, MapWindowx86Full-v488SR-
installer.exe, from the Digital Coast (www.csc.noaa.gov/digitalcoast/tools/opennspect). 

2.	 Run MapWindowx86Full-v488SR-installer.exe. Follow the prompts to install the 
software. A MapWindow GIS icon will be added to your desktop. The software will 
reside at C:\Program Files (x86\MapWindow). 

1.2 Installing OpenNSPECT 

OpenNSPECT is a plug-in extension for MapWindow GIS. Installation requires administrative 
privileges on the target computer. 

1.	 Download the OpenNSPECT installation software, OpenNSPECT_Setup_1_2.exe, from 
the Digital Coast (www.csc.noaa.gov/digitalcoast/tools/opennspect). 

2.	 Be sure that the MapWindow program is not running, and then run 
OpenNSPECT_Setup_1_2.exe. Follow the prompts to install the software. An “NSPECT” 
directory will be installed on your C:\ drive. 

Note: If a previous version of OpenNSPECT is already installed, it should be removed before 
installing a new version. To uninstall the previous version, use the function Add/Remove 
Programs in the Control Panel, select OpenNSPECT, and click Change/Remove. Then follow the 
instructions from the wizard to uninstall the tool. Check the location where OpenNSPECT was 
installed and make sure it is empty (the directory will not be deleted, which is fine). 

1.3 Loading OpenNSPECT 

•	 Open MapWindow GIS. A “Welcome to MapWindow” dialog box will appear. Select 
Close to dismiss the box. 

•	 From the MapWindow pull-down menu, select Plug-ins > OpenNSPECT. This will add 
OpenNSPECT to the main pull-down menu. 
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2. Running an Analysis 

2.1 Setting Up a Project 

Use the Run Analysis option on the main OpenNSPECT menu to define all parameters required 
to perform an analysis within a defined region. 

Use the File menu to create a new project or open an existing project file. Use the Pollutants tab 
to define which pollutants to include in the assessment. Use the Erosion, Land Uses, and 
Management Scenarios tabs to specify optional parameters to consider in the analysis. 
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(A) File: Use the File menu to create a new project, to open a previously defined project, or to 
save a new or modified project. Select New Project to start a new analysis. Select Open Project 
to open an existing project file. Fields in the project setup window will be automatically filled 
with the information that was previously saved. Choose Save or Save As to save the current 
project. 

(B) Project Information: 

•	 Name: To save the parameters in a project file, designate a name for the project when a 
new project is created or an existing project is modified. The parameters that are used 
in each analysis are saved in this project file, which is in .xml format. Be sure to save the 
project under a new name each time you make changes, or the original project 
parameters will be lost. 

•	 Working Directory: Designate a working directory for your project. The working
 
directory will default to C:\NSPECT\workspace.
 

(C) Land Cover: 

•	 Grid: Select the land cover grid that will be used in the analysis. The field contains a 
drop-down list of all grids loaded in the MapWindow project. 

•	 Type: Select the land cover type that matches the selected land cover grid. The drop-
down list contains all currently defined land cover types (see Advanced Settings > Land 
Cover to learn how to add a land cover type). 

(D) Watershed Delineation: Select the watershed delineation data to be used in the analysis 
from the drop-down list of all currently defined watershed delineations, or define a new 
watershed delineation (see Advanced Settings > Watershed Delineations to learn how to add a 
watershed delineation). These water quality standards can be acquired from state and local 
water quality regulatory agencies. 

(E) Precipitation Scenario: Select the precipitation scenario to be used in the analysis from the 
drop-down list of all currently defined precipitation scenarios, or define a new precipitation 
scenario (see Advanced Settings > Precipitation Scenarios to learn how to add a precipitation 
scenario). 

(F) Soils: 

•	 Hydrologic Soils Data Set: Select the soils configuration that will be used in the analysis. 
The drop-down list contains all currently defined soil configurations. The soils 
configuration specifies the grid that contains spatial values for the hydrologic soil types 
(A, B, C, or D, depending on the soil’s infiltration rates) in the area of interest and the 
grid that contains spatial values for the K factor (soil erodibility factor) in the area of 
interest (see Advanced Settings > Soils to learn how to add a soil configuration). 
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(G) Miscellaneous: 

•	 Selected Polygons Only: Select this check box to perform the analysis on a selected 
area. The analysis will be performed in the entire watershed (or catchment basin) in 
which the polygon is located, but the output will be clipped to the selected area. This 
option is only active if a polygon data layer is loaded in the MapWindow project. 

•	 Include Local Effects: Select this check box to remove the influence of upstream cells 
from the analysis. Local Effects will only account for the runoff, pollutants, and sediment 
yield generated at each cell, rather than incorporating the cumulative effects of 
upstream cells in the watershed. 

2.2 Estimating Pollutant Loads 

Use the Pollutants tab to define which pollutants to include and which coefficient set to apply in 
the analysis. All the pollutants in the database with defined coefficient sets are listed in the 
table. 

Apply: To include a pollutant in the analysis, select the check box in the Apply column. To 
exclude a pollutant from the analysis, clear the check box. The column defaults to cleared, which 
means that the pollutant in that row will not be included in the analysis. 

Pollutant Name: The Pollutant Name column is automatically populated with the name of all 
the currently defined pollutants and cannot be edited in this window (see Advanced Settings > 
Pollutants to learn how to add a pollutant). 

Coefficient Set: Select the appropriate coefficient set for the pollutant from the drop-down list 
of all currently defined coefficient sets for that pollutant (see Advanced Settings > Coefficients 
to learn how to add a coefficient set). 
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Which Coefficient: Select the coefficient type (Type 1, Type 2, Type 3, or Type 4) to be used to 
run the analysis. OpenNSPECT will apply that coefficient type to each land cover class in the area 
of interest. If only one type of coefficient is available, select Type 1. 

Once the pollutants are specified and the other parameters in the project setup window are 
selected, the analysis can be run by pressing the Run button in the bottom right-hand corner of 
the window. Erosion will not be included in the analysis unless the Calculate Erosion option is 
activated on the Erosion tab (see next section). 

2.3 Estimating Sediment Loads (optional) 

Use the Erosion tab to indicate whether you want OpenNSPECT to calculate erosion. The 
content of the erosion tab will change according to whether an event-based precipitation 
scenario or an annual precipitation scenario is selected in the Precipitation Scenario field. 

Event Type Precipitation Scenario: To include erosion calculations in the analysis, select the 
check box beside Calculate Erosion for Event Type Precipitation Scenario. 

Annual Type Precipitation Scenario: To include erosion calculations in the analysis, select the 
check box beside Calculate Erosion for Annual Type Precipitation Scenario. 

•	 K Factor Data Set: This shows the K factor grid associated with the soils configuration 
selected in the Soils Definition drop-down list. The K factor is an erodibility factor 
needed to estimate soil loss. The erodibility factor is based on soil characteristics and 
can be acquired from the Natural Resources Conservation Services (NRCS) Soil Survey 
Geographic (SSURGO) Database. 

•	 Rainfall Factor: The Rainfall Factor frame becomes available if the selected precipitation 
scenario is an annual precipitation scenario. The rainfall factor (also called the runoff 
erosivity factor) quantifies the effects of raindrop impacts and reflects the amount and 
rate of runoff associated with the rain. Rainfall factors can also be acquired from the 
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NRCS SSURGO data set. To use a grid, check Use GRID and select the appropriate grid 
from the drop-down list of grids loaded in the MapWindow project. To use a constant 
value, check Use Constant Value and enter a valid numeric value greater than zero. This 
constant rainfall factor value will be applied for the entire study area. 

•	 Sediment Delivery Ratio GRID: The Sediment Delivery Ratio (SDR) GRID is a raster data 
set that is used to calculate the amount of sediment delivered from a cell. The Universal 
Soil Loss Equation calculates the amount of sediment that is mobilized from an area, and 
the SDR is used to adjust the amount of sediment that actually leaves a cell. 
OpenNSPECT automatically calculates the SDR grid using the digital elevation model 
associated with the specified watershed delineation when an annual erosion analysis is 
run, but users are also encouraged to specify their own SDR grid here if one is available. 

2.4 Incorporating Scenarios 

2.4.1 Land Uses 

Use the Land Uses tab to define a specific land use and new Soil Conservation Service (SCS) 
curve number and pollutant coefficient set for a particular area. OpenNSPECT will use this new 
land use scenario to calculate runoff, pollutant, and sediment loads in this area. The original 
land cover grid values will be ignored in the calculation. For example, if a known area is a landfill, 
a new land use type “landfill” can be defined with appropriate coefficients that are applied only 
to that area. 

Note: When both a land use scenario and a management scenario (see next section) are 
selected for the same area, the management scenario will be performed first. The final result in 
the overlapping area will reflect the land use scenario that was specified. 

• Apply: To include a land use scenario in the analysis, select the check box in the Apply 
column. To exclude the land use scenario from the analysis, clear the check box. The 
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column defaults to cleared, which means that the land use scenario in that row will not 
be included in the analysis. 

•	 Land Use Scenario: The Land Use Scenario column on the Land Uses tab displays all the 
land use scenarios that have been defined for the current project. Add, edit, or delete a 
scenario by right-clicking within the table. 

Add Land Use Scenario 

A new scenario can be added to OpenNSPECT by right-clicking in the table on the Land Uses 
tab and selecting Add Scenario from the drop-down list. 

•	 Scenario Name: Provide a name for the new scenario being added (limit of 35 
characters). 

•	 Layer: Select the polygon layer that delineates the area of your land use. The drop-down 
list contains all defined polygon layers in the MapWindow project. The new land use 
type will be applied to the entire selected layer. 

Note: When both a land use scenario and a management scenario are selected for the 
same area, the management scenario will be performed first. 
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•	 SCS Curve Numbers: Designate SCS curve numbers for the new land use type for each 
soil type (A, B, C, and D). The SCS curve numbers represent the infiltration of 
precipitation into the soil and are used when calculating runoff and erosion. The water 
that infiltrates is not included in the flow accumulation calculations; therefore, a more 
accurate prediction of the total runoff is provided. SCS curve numbers are percentages 
entered into OpenNSPECT in decimal form as numbers between 0 and 1; the higher the 
curve number, the greater the amount of runoff. The four columns, A, B, C, and D, 
represent the curve numbers for each of the four hydrologic soil types, which indicate 
the soil’s minimum infiltration rate. Group A soils (typically sand or gravel) have the 
highest infiltration potential, and Group D soils (typically clay soils) have the lowest 
infiltration potential. Group B soils (typically silt with fine to moderately course textures) 
have a moderate infiltration rate, and Group C soils (typically sandy clay with a 
moderately fine to fine texture) have a low infiltration rate. 

•	 Cover Factor: Specify a cover factor for the new land use type. The cover factor is 
defined as the ratio of soil loss from land under specified vegetative or mulch conditions 
to the corresponding loss from tilled, bare soil. More dense cover slows water and 
prevents it from flowing down a slope, quickly carrying sediment. The lower the cover 
factor, the better the vegetative cover is at preventing erosion. The higher the cover 
factor, the more erosion that will result in that area. For example, grasslands generally 
have a much lower cover factor than bare land because the vegetation will help prevent 
soil erosion. 

•	 Water/Wetlands: Select the Water/Wetlands check box if the land use type is water or 
a wetland. This information is required to accurately calculate erosion. 

•	 Pollutant: Each pollutant that the user has defined within OpenNSPECT will be listed in 
the pollutant column. This column cannot be edited. 

•	 Coefficients: Specify a coefficient for each pollutant that may result from this land use 
type. Only one type of coefficient must be specified. The Type 2, Type 3, and Type 4 
columns can be used in cases where some phenomenon will cause the coefficients for 
each pollutant to change. 

2.4.2 Management Scenarios 

Use the Management Scenarios tab to change the land cover within a specified region to a 
different land cover class that is already defined in the land cover classification being used in the 
analysis. For example, to estimate the impact of a new housing development, you can create a 
polygon shapefile of the area that will be developed and apply the high-, medium-, or low-
intensity developed land cover class to that specific area. The coefficients for the newly 
designated land cover class will be used in these designated areas rather than the coefficients 
for the original land cover data set. 

Note: The original land cover data set will not be changed, but original coefficients will be 
ignored. When both a land use scenario and a management scenario are selected for the same 
area, the management scenario will be performed first. The final result in the overlapping area 
will reflect the land use scenario that was specified. 
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•	 Apply: To include a management scenario in the analysis, select the check box in the 
Apply column. To exclude the management scenario from the analysis, clear the check 
box. The column defaults to cleared, which means that the management scenario in 
that row will not be included in the analysis. 

•	 Change Area Layer: Select the polygon layer that will be changed to a different land 
cover class. The Change Area Layer drop-down list contains all defined polygon layers in 
the MapWindow project. 

•	 Change to Class: Select the new land cover class that will be applied to the polygon 
layer. The Change to Class drop-down list contains all land cover classes for the selected 
land cover type. 
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Add Management Scenario 

There are three options, available via a pop-up menu, to edit the management scenario 
parameters. Access the pop-up menu by right-clicking within the table. 

•	 Append Row: Add a new management scenario to the end of the table by selecting 
Append Row from the pop-up menu that displays by right-clicking within the table. In 
the Change Area Layer column, select the polygon layer denoting the area where the 
land cover class will change. The column contains a drop-down list of all polygon layers 
defined in the active data frame. Then select the new land cover class for the region. 

•	 Insert Row: Insert a new management scenario into the table by selecting Insert Row 
from the pop-up menu that displays by right-clicking within the table. In the Change 
Area Layer column, select a polygon layer denoting the area where the land cover class 
will change. The column contains a drop-down list of all polygon layers defined in the 
active data frame. Then select the new land cover class for the region. 

•	 Delete Row: Delete an existing management scenario by clicking on the appropriate row 
and selecting Delete Row from the pop-up menu that displays by right-clicking within 
the table. Confirm the choice to delete when prompted, and the selected management 
scenario and its associated information will be deleted from the database. 
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3. Advanced Settings 
The Advanced Settings menu provides access to functionality for viewing, editing, and adding 
region-specific data sets and parameters. Default data sets and parameters are defined for the 
Wai‘anae region and have been provided with OpenNSPECT. Users in the Wai‘anae area who 
choose to use the default data can skip the Advanced Settings section and go directly to the Run 
Analysis menu selection. Users who want to use OpenNSPECT in other regions nationwide can 
use the advanced settings to incorporate data from their local area. For detailed instruction on 
building an NSPECT database, see OpenNSPECT 1.2 Data Acquisition and Preprocessing: 
Instructions for Your watershed (www.csc.noaa.gov/digitalcoast/sites/default/files/uploaded 
/files/OpenNSPECT1.2DataAcquisitionandPreprocessing_InstructionsforYourWatershed.pdf). 

3.1 Clip and Project New Data 

Five spatial layers are required to build an NSPECT database: three rasters and two vectors. The 
raster data include elevation, land cover, and precipitation. When available, a rainfall erosivity 
factor raster layer is used; otherwise a constant value is used. The vector layers are the study 
area boundary and soils data. 

The Clip and Project New Data tool reprojects input raster data to the same projection, clips all 
rasters to the extent of the vector study area boundary, resamples rasters to the same spatial 
resolution, and aligns raster cells to match the elevation raster. 

Final Area of Interest and Projection: 

(A) AOI Shapefile: Select the vector study area boundary file. All input data will be clipped to 
this extent. 

•	 Projection Name: The name of the shapefile projection will be displayed. 
•	 Projection Parameters: The projection, spheroid, and datum information will be 

displayed. 

(B) Final Cell Size: Enter the desired cell size for output raster data. This is typically the 
resolution of the elevation layer. For national scale data, this is typically 30 meters. 

(C) Intermediate Buffer Size: Enter the desired buffer distance for initial raster processing. This 
buffers edges of the clipped raster data to ensure there is sufficient data to align the raster cells 
properly. Generally, this is 20-50 cells. 

Initial Data: 

(D) Elevation Raster: Select the input raster elevation layer. 

•	 Projection Name: The name of the elevation projection will be displayed. 
•	 Cell Size: The input raster resolution will be displayed. 
•	 Projection Parameters: The projection, spheroid, and datum information will be 

displayed. 
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(E) Land Cover Raster: Select the input raster land cover layer. 

•	 Skip: Check this box if you do not need to clip a land cover layer at this time. 
•	 Projection Name: The name of the land cover projection will be displayed. 
•	 Cell Size: The input raster resolution will be displayed. 
•	 Projection Parameters: The projection, spheroid, and datum information will be 

displayed. 

(F) Precipitation Raster: Select the input raster precipitation layer. 

•	 Skip: Check this box if you do not need to clip a precipitation layer at this time. 
•	 Projection Name: The name of the precipitation projection will be displayed. 
•	 Cell Size: The input raster resolution will be displayed. 
•	 Projection Parameters: The projection, spheroid, and datum information will be 

displayed. 

(G) R-Factor Raster: If rainfall factor data are available, select the raster R-Factor layer. 

•	 Skip: Check this box if you do not need to clip a R-Factor layer at this time. 
•	 Projection Name: The name of the R-Factor projection will be displayed. 
•	 Cell Size: The input raster resolution will be displayed. 
•	 Projection Parameters: The projection, spheroid, and datum information will be 

displayed. 

(H) Keep intermediate data: Check this box if you want to keep the intermediate raster layers 
that are produced while this tool is running. Unless some information from these layers is 
needed, it is wise not to check this button to avoid storing unnecessary data on your computer. 

(I) Display AOI and final rasters: Check this box if you want the output data to display in 
MapWindow. If you already have data open in the window that are not in the same projection 
as the final output data, close those files or do not check this button. MapWindow cannot 
display data in different projections in the same window. 
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3.2 Land Cover 

Land cover data are the basis of OpenNSPECT’s functionality. Land cover is used to estimate 
pollutant loads by applying coefficients for individual pollutants to each land cover class. 
OpenNSPECT was designed using NOAA’s Coastal Change Analysis Program (C-CAP) land cover 
data; however, any land cover data can be used in the tool provided the appropriate pollutant 
coefficients have been defined. 

Use the Land Cover Types window to select the land cover type to be viewed or edited. All 
currently defined land cover types are available via the Land Cover Type drop-down list. When a 
land cover type is selected, the remaining fields are automatically populated with information 
about the selected land cover type. Use the Options menu to create, import, delete, or export a 
land cover type. 

Land Cover: Use this to designate the land cover type. The drop-down list contains all currently 
defined land cover types within OpenNSPECT. 

Description: A brief description of the selected land cover type. Provide a description (less than 
100 characters) when importing or creating a new land cover type data set. 
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Classification: This column contains the grid value and corresponding name for each land cover 
class in the currently selected land cover type. Provide values and names when creating a new 
land cover data set. 

SCS Curve Numbers: The SCS curve numbers represent the infiltration of precipitation into the 
soil. The water that infiltrates is not included in the flow accumulation calculations; therefore, a 
more accurate prediction of the total runoff is provided. SCS curve numbers are percentages 
entered into OpenNSPECT in decimal form as numbers between 0 and 1; the higher the curve 
number, the greater the amount of runoff. The four columns, CN-A, CN-B, CN-C, and CN-D, 
represent the curve numbers for each of the four hydrologic soil types, which indicate the soil’s 
minimum infiltration rate. Group A soils (typically sand or gravel) have the highest infiltration 
potential, and Group D soils (typically clay soils) have the lowest infiltration potential. Group B 
soils (typically silt with fine to moderately course textures) have a moderate infiltration rate, and 
Group C soils (typically sandy clay with a moderately fine to fine texture) have a low infiltration 
rate. For instances where a dual hydrologic group is assigned (for example, A/D, B/D, C/D), the 
highest curve number of the two components is used (see the OpenNSPECT Technical Guide for 
a detailed description). Default values for C-CAP land cover data are provided with OpenNSPECT. 
Provide SCS curve number values when creating a new land cover data set. 

Hydrologic Soil Group Definitions 
Hydrologic Soil Group Soil Group Characteristics 

A 
Soils having high infiltration rates, even when thoroughly wetted, and 
consisting chiefly of deep, well-drained to excessively drained sands or 
gravels. These soils have a high rate of water transmission. 

B 

Soils having moderate infiltration rates when thoroughly wetted and 
consisting chiefly of moderately deep to deep and moderately fine to 
moderately coarse textures. These soils have a moderate rate of water 
transmission. 

C 

Soils having slow infiltration rates when thoroughly wetted and consisting 
chiefly of soils with a layer that impedes downward movement of water, or 
soils with moderately fine to fine texture. These soils have a slow rate of 
water transmission. 

D 

Soils having very slow infiltration rates when thoroughly wetted and 
consisting chiefly of clay soils with a high swelling potential, soils with a 
permanent high water table, soils with a claypan or clay layer at or near the 
surface, and shallow soils over nearly impervious material. These soils have 
a very slow rate of water transmission. 

RUSLE: The Cover Factor and Wet columns are values used in the revised universal soil loss 
equation (RUSLE) to calculate erosion. The cover factor is typically a number between 0 and 1, 
and is essentially the ratio of soil loss from land under specified vegetative conditions to the 
corresponding loss from bare soil. The cover factor reduces the soil loss estimate according to 
the effectiveness of vegetation at preventing detachment and transport of soil particles. The 
higher the value, the more erosion that occurs (for example, bare land has a relatively high 
cover factor). Default values for C-CAP data are provided with OpenNSPECT. Provide cover 
factor values when creating a new land cover data set. The Wet column designates whether the 
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land cover type is water or wetland. If the land cover class is water or wetland, the check box in 
this column should be selected. For any non-water class, the check box should be cleared. This 
distinction is necessary for an accurate calculation of erosion. 

Add Land Cover Type 

In the Land Cover Type dialog box, go to Options > New. 

Land Cover Type: Provide a name for the new land cover type being added (limit of 35 
characters). 

Description: Provide a brief description (less than 100 characters) of the new coefficient set. 

Classification: Input the grid value (Value column) and corresponding name (Name column) for 
each land cover class in the new land cover type. To add, insert, or delete a row, right-click in 
the table. 

SCS Curve Numbers: Specify the SCS curve numbers in the CN-A, CN-B, CN-C, and CN-D columns. 
Curve numbers represent the infiltration of precipitation into the soil. The four columns 
represent the curve numbers for each of the four hydrologic soil types, which indicate the soil’s 
minimum infiltration rate. The water that infiltrates is not included in the flow accumulation 
calculations; therefore, a more accurate prediction of the total runoff is provided. SCS curve 
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numbers are percentages entered into OpenNSPECT in decimal form as numbers between 0 and 
1; the higher the curve number, the greater the amount of runoff. 

Group A soils (typically sand or gravel) have the highest infiltration potential, and Group D soils 
(typically clay soils) have the lowest infiltration potential. Group B soils (typically silt with fine to 
moderately course textures) have a moderate infiltration rate, and Group C soils (typically sandy 
clay with a moderately fine to fine texture) have a low infiltration rate. For instances where a 
dual hydrologic group is assigned (for example, A/D, B/D, C/D), the highest curve number of the 
two components is used. 

RUSLE: Specify the cover factor for each land cover type. The cover factor is typically a number 
between 0 and 1, and is essentially the ratio of soil loss from land under specified vegetative 
conditions to the corresponding loss from bare soil. The cover factor reduces the soil loss 
estimate according to the effectiveness of vegetation at preventing detachment and transport 
of soil particles. The higher the value, the more erosion that occurs (for example, bare land has a 
relatively high cover factor). 

Specify whether the land cover type is water or wetland in the Wet column. If the land cover 
class is water or wetland, the box in this column should be checked. For any non-water class, the 
box should be left unchecked. This distinction is necessary for an accurate calculation of erosion. 

Delete Land Cover Type 

To delete an existing land cover type, select the land cover type to be deleted from the Land 
Cover Type drop-down list and choose Delete from the Options menu. The selected land cover 
type and all associated coefficient sets will be deleted from OpenNSPECT’s database and will no 
longer appear in the Land Cover Type drop-down list. 

Note: The C-CAP land cover type cannot be deleted. 

Import Land Cover Type 

The import function will allow you to use land cover data sets from other OpenNSPECT users 
without entering them by hand. Other users can use the export function to save the land cover, 
curve numbers, and cover factor in the appropriate format. To import a land cover type, select 
Import from the Options menu. Name the file and navigate to the folder in which it is located. 
The imported file must be an ASCII file containing a header row, followed by a row of comma-
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separated values for each land cover class. The header row should contain the name of the land 
cover type and a description, separated by a comma (no space). Each row must contain seven 
fields ordered as follows: Value,name,Curve#-A,Curve#-B,Curve#-C,Curve#-D,CoverFactor,Wet. 
Supply a name for the new land cover type when it is imported. The new land cover type will be 
added to the Land Cover Type drop-down list. 

Export Land Cover Type 

The export function will allow you to share land cover data sets with other OpenNSPECT users, 
who can use the import function to load the land cover, curve numbers, and cover factor 
without entering the values by hand. To export a land cover type, select the land cover type to 
be exported from the Land Cover Type drop-down list and choose Export from the Options 
menu. Name the exported file and designate a location in which to save the file. The land cover 
classes are written to a comma-separated ASCII file containing a row of values for each land 
cover class. The file contains a header row with the name of the land cover type and the 
description. Each row contains seven fields ordered as follows: Value,name,Curve#-A,Curve#-
B,Curve#-C,Curve#-D,CoverFactor,Wet. 

3.3 Pollutants 

The primary focus of OpenNSPECT is nonpoint source pollutants. OpenNSPECT applies 
coefficients representing the expected pollutant load from each land cover type to approximate 
total nonpoint source pollutant loads. The accuracy of OpenNSPECT’s pollutant results depends 
on these coefficients. To apply the tool to other areas, you should develop coefficients based on 
local data when possible. 

Use the Pollutants dialog box to view or edit information about previously defined pollutants, to 
define new pollutants, or to delete pollutants that are no longer needed. Use the Pollutants 
menu to add or delete a pollutant. Use the Coefficients menu to create, copy, delete, import, or 
export a coefficient set. 

19 



 

 

    
    

     
      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

View or Modify Pollutant 

To modify an existing pollutant, select Advanced Settings and Pollutants. Select the pollutant of 
interest in the Pollutant Name drop-down list. The list will display all the currently defined 
pollutants within OpenNSPECT. Fields in the Pollutants window are populated according to the 
selected pollutant. Use the Coefficients tab to view or edit information about the defined 
coefficient sets for the selected pollutant. 
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Add Pollutant 

To add a new pollutant, select Add from the Pollutants menu. 

Pollutant Name: Provide a name for the new pollutant being added (limit of 35 characters). 

Coefficient Set: Provide a name for the coefficient set to associate with the new pollutant. 

Land Cover Type: Select the type of land cover that will be used to define new coefficients for 
the pollutant being added. 

Description: Provide a brief description (less than 100 characters) of the new coefficient set. 

Class: The Value and Name columns contain the grid value and corresponding name for each 
land cover class defined for the associated land cover type. These values cannot be edited. 

Coefficients: Enter coefficients into the table for each land cover class. Only one type of 
coefficient is required, so only one column must be completed, but the functionality to enter 
four different types of coefficients is available. The coefficients give the average concentration 
of the selected pollutant that is released by the identified land cover during a precipitation 
event. This is frequently referred to as the Event Mean Concentration. 
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Delete Pollutant 

To delete an existing pollutant, select the desired pollutant for deletion and select Delete from 
the Pollutants menu. 

Confirm the choice to delete when prompted. The pollutant, all associated coefficient sets, and 
all references to the pollutant in water quality criteria will be deleted from the database. 

3.4 Coefficients 

Coefficients give the average concentration of the selected pollutant that is released by the 
identified land cover during a precipitation event. This is frequently referred to as the Event 
Mean Concentration. 

Add New Coefficient Set 

To create a new coefficient set, select the pollutant for which you want to create a new 
coefficient set in the Pollutant drop-down field and select New Set from the Coefficients menu. 
Designate a Coefficient Set Name and associate a land cover type in the Land Cover Type field. 
Click OK and a new coefficient set will be created, with the values defaulting to zero. Enter a 
description of the coefficient set. Enter a coefficient for each land cover class defined for the 
land cover type. Values must be entered for at least one of the four types (Types 1 through 4). 

Copy Coefficient Set 

To copy a coefficient set, select Copy Set from the Coefficient menu. Designate a coefficient set 
to copy from and a new coefficient set name. The Copy from Coefficient Set drop-down menu 
will contain all defined coefficient sets for the selected pollutant. Click OK and a new coefficient 
set will be created that is identical to the coefficient set selected in the Copy from Coefficient 
Set field. The coefficient values may be edited for the new set. 

22 



 

  

  

   
 

  

  

      
  

      
       

    
       

  
    

  

  

 

 

Delete Coefficient Set 

To delete an existing coefficient set, select the desired coefficient set for deletion and select 
Delete Set from the Coefficient menu. Confirm the choice to delete when prompted. The 
selected coefficient set will be deleted from the database. 

Import Coefficient Set 

To import a coefficient set, select Import Set from the Coefficients menu. Specify a name for the 
coefficient set to be imported and the land cover type that will be associated with it. Browse for 
the coefficient set file that contains the values to be imported. The file must contain a header 
row with the name of the land cover type and a description, separated by a comma (no space). 
The imported file must be an ASCII file containing a row of comma-separated values for each 
land cover class. Each row must contain five fields ordered as follows: Value,Type 1,Type 2,Type 
3,Type 4. The new coefficient set will be added to the Coefficient Set drop-down list. The 
associated land cover type should match the land cover values defined within the import file. 
The new coefficient set will be added to the Coefficient Set drop-down list. 
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Export Set 

To export a coefficient set, select Export Set from the Coefficients menu. Name the file and 
designate a location to save it. The coefficient set will be written to a comma-separated ASCII 
file containing a row of values for each land cover class. Each row will contain five fields ordered 
as follows: Value,Type 1,Type 2,Type 3,Type 4. 

3.5 Precipitation Scenarios 

The intensity, length of precipitation event, and amount of precipitation that falls during an 
event has a large impact on the amount of erosion that occurs during the rainfall. Erosion is 
calculated differently using annual precipitation data than it is using event-specific data. The 
RUSLE is used to calculate average annual erosion with annual precipitation data, while the 
modified universal soil loss equation (MUSLE) is used to calculate erosion from specific events 
and requires event-specific rainfall data. 

A precipitation scenario must be specified to calculate runoff within OpenNSPECT. The 
precipitation scenarios that are defined within OpenNSPECT can be modified or new scenarios 
can be created. OpenNSPECT also provides the ability to delete precipitation scenarios. 
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Modify Precipitation Scenario 

To modify an existing precipitation scenario, select Advanced Settings > Precipitation Scenarios. 
Fields in the Precipitation Scenarios window are populated according to the selected scenario. 

Scenario Name: This field contains a drop-down list of all the currently defined precipitation 
scenarios. Fields in the Precipitation Scenarios window are populated according to the selected 
scenario name. This field cannot be edited. 

Description: This box provides a brief description of the selected precipitation scenario. The 
description for the precipitation scenario can be modified and saved. 

Precipitation Grid: The precipitation grid contains spatial values for precipitation over the area 
of interest. The name and path of the precipitation grid are displayed. To change the 
precipitation grid associated with the scenario, use the browse button to select a precipitation 
grid for your analysis and choose Add. 

Grid Units: This field defines cell size units (meters or feet) of the specified precipitation grid. 

Precipitation Units: This box defines the precipitation units (centimeters or inches) used in the 
precipitation grid. 

Time Period: This field specifies the type of precipitation scenario—annual or event—depending 
on the precipitation data set that is being used. Annual precipitation events will use different 
methods for estimating soil erosion than event-based precipitation events. 

The annual and event types of precipitation scenarios for Wai’anae were developed in conjunc-
tion with the Hawaii state climatologist. See the OpenNSPECT technical guide for specific details. 

Raining Days: This number indicates the average number of storms that occur in a one-year 
period in the area of interest. This parameter is very sensitive and typically requires careful 
consideration. While it isn’t recommended that users simply adjust this value to calibrate 
OpenNSPECT to local conditions, users are encouraged to employ creative methods to 
accurately reflect spatial variation in raining days. 

Type: This field specifies the rainfall type in the analysis region. The different rainfall types 
describe the four synthetic 24-hour rainfall distributions developed by the NRCS. The National 
Weather Service’s duration-frequency data or local storm data were used to develop these 
distributions. All of Hawaii is Type I rainfall (see following table for descriptions of rainfall types). 
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NRCS Rainfall Distributions 
Type Description 

Types I and IA Pacific maritime climates with wet winters and dry summers. Type IA is the least 
intense rainfall. 

Type II Most of the country falls into this category. Type II is the most intense short duration 
rainfall. 

Type III Atlantic coastal areas and the Gulf of Mexico where tropical storms with large 24-hour 
rainstorms occur. 

New Precipitation Scenario 

A new precipitation scenario can be created in one of two ways: 

•	 In the Run Analysis project window, use the Precipitation Scenario drop-down menu to 
select New precipitation scenario. All the defined precipitation scenarios will be listed in this 
drop-down menu, but the last entry in the list will give the option to create a new 
precipitation scenario. 

•	 Select Precipitation Scenarios under Advanced Settings and select New from the Options
 
menu. Either one of these options will take you to the New Precipitation Scenario dialog.
 

Scenario: Provide a name for the new precipitation scenario being added (limit of 35 
characters). 

Description: Provide a brief description (less than 100 characters) of the new precipitation 
scenario. 
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Precipitation Grid: Use the browse button to select the precipitation grid to associate with this 
precipitation scenario. 

Grid Units: Specify the cell size units (meters or feet) of the specified precipitation grid. This 
information may be found in the metadata for the precipitation data set. 

Precipitation Units: Specify the precipitation units (centimeters or inches) that are reported in 
the precipitation grid. This information may be found in the metadata for the precipitation data 
set. 

Time Period: Specify the type of precipitation scenario, annual or event, depending on the type 
of precipitation data you are using. Different methods will be used to estimate soil erosion from 
annual precipitation data than from event-based precipitation data. To avoid confusion, your 
scenario name should accurately reflect the time period you have chosen. 

Type: Specify the rainfall type in the analysis region. The different rainfall types describe the 
four synthetic 24-hour rainfall distributions developed by the NRCS. The National Weather 
Service’s duration-frequency data or local storm data were used to develop these distributions. 
All of Hawaii is Type I rainfall. 

Delete Precipitation Scenario 

To delete an existing precipitation scenario, select the desired precipitation scenario for deletion 
in the Scenario Name field and select Delete from the Options menu. Confirm the choice to 
delete when prompted and the selected precipitation scenario will be deleted from the 
database. 

3.6 Watershed Delineations 

Watersheds are a common and logical analysis unit for conducting water quality assessments. 
The first step in creating a vector layer of watershed polygons is to load a digital elevation model 
(DEM). OpenNSPECT generates a flow direction grid, flow accumulation grid, vector watersheds 
layer, and length-slope (LS) factor grid when a new watershed delineation is created. 

The watershed delineations that are already defined within OpenNSPECT are listed in the 
Watershed Delineation Name drop-down list in the Watershed Delineations window. Fields in 
the Watershed Delineations window are populated according to the selected watershed 
delineation name. OpenNSPECT provides the ability to create a new watershed delineation, 
delete an existing watershed delineation, and enter the unique components of a watershed 
delineation. 
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Watershed Delineation Name: This field contains all the currently defined watershed 
delineations within OpenNSPECT. Fields in the Watershed Delineations window are populated 
according to the selected watershed delineation name. 

DEM Grid: The DEM Grid field provides topography data for use in OpenNSPECT analyses and is 
automatically populated with the DEM grid defined for the selected watershed delineation. This 
field cannot be edited. The tool was developed and tested using 30-meter DEMs from the U.S. 
Geological Survey (USGS), although other DEMs may also be used. 

Units: This field is automatically populated with the DEM grid units (meters or feet) defined for 
the selected watershed delineation. This field cannot be edited in this window. 

Hydrologically Corrected DEM: Select the Hydrologically Corrected DEM check box if you have 
already hydrologically corrected the DEM by filling sinks. If this check box is cleared, 
OpenNSPECT will automatically perform this hydrological correction process before creating the 
watershed delineation. 

Subwatershed Size: Subwatershed size designates the subwatershed size (small, medium, or 
large) for the selected watershed delineation. The subwatershed size is relative to the DEM; a 
small subwatershed is 3 percent of the maximum flow accumulation value, a medium 
subwatershed is 6 percent of the maximum flow accumulation value, and a large subwatershed 
is 10 percent of the maximum flow accumulation value. This field cannot be edited in this 
window. 

Watershed: This field displays the watershed file that was created in the watershed delineation 
process. 
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Flow Accumulation Grid: This field displays the accumulation grid that was created when the 
selected watershed delineation was created. Each cell in the flow accumulation grid contains the 
total value of all cells upstream of that cell. 

LS Grid: The LS Grid is the length-slope grid that is used in calculating erosion. Length-slope is a 
parameter needed to use the MUSLE equation to estimate soil loss from a short-term rain event. 

Add New Watershed Delineation 

A new watershed delineation can be created in one of two ways: 

1.	 New 
o	 Automatic delineation from user-specified DEM. 
o	 In the Run Analysis project window, use the Watershed Delineation drop-down 

menu to select New watershed delineation. All the defined watershed 
delineations will be listed in this drop-down menu, but the last entry in the list 
will give the option to create a new watershed delineation. 

o	 Select Watershed Delineations under Advanced Settings and select New from 
the Options menu. Either one of these options will take you to the New 
Watershed Delineation dialog box. 

2.	 New from existing data 
o	 Manual input of watershed delineation files. This option is designed for the 

power user who wants to have maximum control over the DEM-derived data 
layers. 

New delineation from user-specified DEM: 

Delineation Name: Provide a name for the new watershed delineation being added (limit of 35
 
characters).
 

DEM Grid: Browse to the DEM Grid that will be used for the analysis in the area of interest.
 

DEM Units: Specify the DEM grid units (meters or feet) for the selected DEM.
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DEM is hydrologically correct (filled): Check the DEM is hydrologically corrected box if the DEM 
has already been hydrologically corrected by filling sinks. If this check box is cleared, 
OpenNSPECT will automatically perform this hydrological correction process before running the 
analysis. 

Subwatershed Size: Select the subwatershed size to indicate the approximate subwatershed 
size (small, medium, or large) for the selected watershed delineation. The subwatershed size is 
relative to the DEM; a small subwatershed is 3 percent of the maximum flow accumulation 
value, a medium subwatershed is 6 percent of the maximum flow accumulation value, and a 
large subwatershed is 10 percent of the maximum flow accumulation value. 

Note: This field cannot be edited in this window. 

Click OK to derive the new watershed delineation and process all associated files. 

New from existing data: 

Users can create a new watershed delineation using derivatives created outside of OpenNSPECT. 

Watershed Delineation Name: Provide a name for the new watershed delineation being added 
(limit of 35 characters). 

DEM Grid: Browse to the DEM Grid that will be used for the analysis in the area of interest. This 
grid should be hydrologically corrected. 

DEM Units: Specify the DEM grid vertical units (meters or feet) for the selected DEM. 

30 



 

   

  

  

   

 

  

 
    

   
 

 

  

  
      

    
  

       
     

    
 

 

 

 

 

 

Flow Direction Grid: Select the flow direction grid. 

Flow Accumulation Grid: Select the flow accumulation grid. 

Length-Slope Grid: Select the length-slope grid. 

Watersheds: Select the shapefile polygon that represents unique watersheds. 

Delete a Watershed Delineation 

To delete an existing watershed delineation, select the desired watershed delineation for 
deletion in the Delineation Name field and select Delete from the Options menu. Confirm the 
choice to delete when prompted and the selected watershed delineation will be deleted from 
the database. 

3.7 Soils 

Soils data are used to estimate sediment loads using the NRCS-developed RUSLE and MUSLE 
equations. RUSLE is used to estimate average erosion over time, whereas MUSLE is used to 
estimate erosion from specific rainfall events. OpenNSPECT was developed using soils data from 
the SSURGO database; however, any land soils data can be used in the tool provided the data 
are in the appropriate format. The soils configurations that are defined within OpenNSPECT are 
listed in the Name drop-down list in the Soils window. Fields in the Soils window are populated 
according to the selected soil name. OpenNSPECT provides the ability to create a new soils 
configuration or delete a soils configuration. 
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Add New Soils Configuration 

To define a new soils data set, select Advanced Settings and then Soils, and select New from the 
Options menu. 

Name: Provide a name for the new soils configuration being added (limit of 35 characters). 

DEM GRID: Browse to specify the DEM Grid that you are using in the analysis area. This should 
match the DEM grid used in the watershed delineation process. 

Soils Data Set: Select the soils data set (polygon shapefile layer) that contains soils information 
for the area of interest. The soils data currently provided in OpenNSPECT were acquired from 
the U.S. Department of Agriculture (USDA) NRCS SSURGO database. Although these data are 
available for download on the Web, a few modifications are necessary before they can be 
loaded into OpenNSPECT. See the OpenNSPECT technical guide for information on processing 
the soils data. 

Hydrologic Soil Group Attribute: Select the attribute in the soils data set that corresponds to 
the hydrologic soil group information. The hydrologic group (hydgrp) is an attribute found in the 
component table of the SSURGO database. The hydrologic group is assigned based on soil 
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infiltration rates. These are grouped into four categories, A through D, based on decreasing 
infiltration (A = high infiltration, D = very slow infiltration). 

Hydrologic Soil Group Definitions 
Hydrologic Soil Group Soil Group Characteristics 

A 
Soils having high infiltration rates, even when thoroughly wetted and 
consisting chiefly of deep, well- to excessively drained sands or gravels. 
These soils have a high rate of water transmission. 

B 

Soils having moderate infiltration rates when thoroughly wetted and 
consisting chiefly of moderately deep to deep, and moderately fine to 
moderately coarse textures. These soils have a moderate rate of water 
transmission. 

C 

Soils having slow infiltration rates when thoroughly wetted and consisting 
chiefly of soils with a layer that impedes downward movement of water, or 
soils with moderately fine to fine texture. These soils have a slow rate of 
water transmission. 

D 

Soils having very slow infiltration rates when thoroughly wetted and 
consisting chiefly of clay soils with a high swelling potential, soils with a 
permanent high water table, soils with a claypan or clay layer at or near the 
surface, and shallow soils over nearly impervious material. These soils have 
a very slow rate of water transmission. 

K Factor Attribute: Select the attribute in the soils data set that corresponds to the K factor. The 
K factor (kffact) is an attribute found in the chorizon table of the SSURGO database. This factor is 
derived from the amount of soil lost per unit of erosive energy in the rainfall, assuming a 
standard research plot. It is an erodibility factor that quantifies the susceptibility of soil particles 
to detachment and movement by water. The K factor is used in RUSLE and MUSLE to calculate 
soil loss by water. The two most important factors related to soil erodibility are infiltration 
capacity and structural stability. Low infiltration capacity would cause more surface runoff, and 
the surface is less likely to be ponded, making soil more susceptible to splashing. Some 
properties that create a high K factor value are high contents of silt and clay, or impervious soil 
layers. Areas without a K factor value (disturbed soils) will be assumed to carry a K value of 0.30. 

Advanced MUSLE Specific Parameters: MUSLE requires two constants that can be locally 
calibrated to estimate event-based erosion. In the Advanced MUSLE Specific Parameters 
section, the universal MUSLE equation is given under “MUSLE Equation for sediment yield.” The 
user can enter locally specific constants into the text boxes under “MUSLE Equation for 
Sediment Yield.” 

Delete Soils Configuration 

To delete an existing soils data set, select the desired soils data set for deletion in the Name field 
and select Delete from the Options menu. Confirm the choice to delete when prompted and the 
selected soils data set will be deleted from the database. 
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4. Output 

OpenNSPECT produces three primary types of pollution and erosion output estimates. These are 
local effects, accumulated effects, and pollutant concentration. The local effects outputs are 
estimates of the amount (in units of mass) of pollutants or sediments that are originating from 
that particular location. The accumulated effects outputs are estimates of the total pollutant or 
sediment load delivered to/through a location, again in units of mass. The concentration 
outputs are estimates of the average concentration at a location, given what is flowing in from 
upstream. These are in units of concentration (mass/volume). If there is nothing coming from 
upstream, these would be the same as the pollutant coefficients. Note that there are no 
concentration results from the RUSLE/MUSLE calculations. 

Output data sets are organized and displayed in the MapWindow Legend using group layers. 
Data sets that result from running an OpenNSPECT analysis for accumulated effects will include 

•	 Accumulated runoff volume grid (liters). This grid displays accumulated values of water 
volume at each cell in the analysis area. These values are used in calculating the 
pollutant and sediment concentration grids by dividing the pollutant/sediment 
accumulation grid by the water volume to give a concentration. 

•	 Accumulated pollutant grid (kilograms). This grid displays the accumulated load of the 
specified pollutant at each cell in the analysis area. 

•	 Pollutant concentration grid (milligram per liter). Each cell in this grid gives an estimate 
of the concentration of the specific pollutant at that location. The user can easily 
identify specific areas of concern that may be logical targets for further monitoring. 

•	 Accumulated sediment load grid (kilograms). A total sediment load grid is created for 
each OpenNSPECT run for which the user chooses to calculate erosion. 

Data sets that result from running an OpenNSPECT analysis for local effects will also include 

•	 Local runoff grid (liters). This grid displays the volume of runoff from each cell in the 
analysis area. 

•	 Local pollutant grid (milligrams). This grid displays the amount (mass) of the specified 
pollutant that is coming off of each cell in the analysis area. 

•	 Local sediment load grid (milligrams). This grid displays the amount of sediment (mass) 
that is eroding from each cell in the analysis area. 

4.1 Comparing Outputs 

Making comparisons of the difference in water quality between a baseline landscape and a 
landscape after some management scenario is the heart and soul of OpenNSPECT. The Compare 
Outputs tool helps users easily do this by calculating the absolute change and the percentage 
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change between two different OpenNSPECT runs. These runs can include local effects, 
accumulated effects, and pollutant concentration. 

•	 Direct Comparison (Management - Baseline) produces a grid of the difference, between 
the modified scenario and the original scenario, in units of the original data. Zero equals 
no change, positive numbers indicate the land use changes caused an increase, and 
negative numbers indicate the land use changes caused a decrease in the variable 
measured. Note that this interpretation depends on entering the changed scenario in 
the left pane and the original scenario in the right pane. 

•	 Percent Change (100 * (Management - Baseline) / Baseline) produces a grid of the 
relative difference, between the modified scenario and the original scenario, expressed 
as a percentage change from the original values. Zero equals no change, positive 
numbers indicate the land use changes caused an increase, and negative numbers 
indicate the land use changes caused a decrease in the variable measured. Note that 
this interpretation depends on entering the changed scenario in the left pane and the 
original scenario in the right pane. 

Compare Outputs 

Select Compare Outputs from the OpenNSPECT toolbar. All OpenNSPECT output group layers 
will be displayed in the left and right selection boxes. Choose a modified (that is, a management 
or land use scenario run in the left box and a baseline scenario for the same area in the right 
box. 
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Limit Output Selection to Those in the MapWindow Legend 

To view only the layers currently open in MapWindow, click the Show Only Output Group from 
Legend check box. 
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5. Metadata 
Each data set that is delivered with OpenNSPECT has a metadata file associated with it that can 
be accessed with the MapWindow View Metadata tool. The same is true for each output data 
set that is created with OpenNSPECT. Each time a new analysis is completed, metadata are 
created for each output data set, which includes information such as the OpenNSPECT project 
the output file is associated with and the parameters that were chosen to run the tool when the 
data set was created. 
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6. Hints and Acronyms 
Right-clicking within the tables contained in the OpenNSPECT window will allow you to append a 
row (add a blank row at the end of the grid), insert a row (insert a blank row above the current 
row), or delete a row from the table. 

ASCII: American Standard Code for Information Interchange 

C-CAP: Coastal Change Analysis Program 

DEM: digital elevation model 

LS: length-slope 

MUSLE: modified universal soil loss equation 

NOAA: National Oceanic and Atmospheric Administration 

NRCS: Natural Resources Conservation Service 

NWS: National Weather Service 

RUSLE: revised universal soil loss equation 

SCS Curve Number: Soil Conservation Service Curve Number 

SDR: sediment delivery ratio 

SSURGO Database: Soil Survey Geographic Database 

USDA: United States Department of Agriculture 

USGS: United States Geological Survey 
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